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Contact Mark for a free consultation and find out how he can help you! 
mark@ddroom.com ~ (503) 977-2400

Online Lightroom & Photoshop Training with Mark Fitzgerald 
Take your creativity to the next level

• Use free web meeting software with screen sharing. 

• Customized training and support designed for your needs. 

• Create an organized and efficient editing workflow. 

• Get problems solved and focus on your personal creative vision. 

• Improve skills so you’re getting the most from your images.  
• Learn from an expert who has helped photographers worldwide.  

        See testimonials from real people at www.ddroom.com.

Become a better 
photographer

Learn in the privacy of your 
home or office

Schedule training at a time 
that works for you



 

1.  Basic Lightroom Concepts 

2.  Importing New Photos 

3.  Quick & Easy Sorting 

4.  Batch Editing Groups of Photos 

5.  Exporting for the Lab and Clients 
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Overview 



 

!  Free Videos:  
!  http://www.ddroom.com/free-lightroom-videos/ 
 
!  Book: Zen of Postproduction: Available at Amazon 

and bookstores worldwide. 

!  Download this handout:  
!  http://www.ddroom.com/mppa-handout/ 
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Resources 



  

Understanding 

Lightroom 



!  Photoshop is like having every tool from the hardware 
store all in one big toolbox. Quite often, it’s hard to find 
the right tool for the job because you don’t know what it 
looks like or where to look for it. After you find the tool, 
you need to learn to use it. 

!  Lightroom is like having just the tools photographers 
use the most. What’s more, they’re arranged on the 
virtual workbench in the order in which they’re most 
commonly used. 

!  Lightroom’s organizational features are easier to use 
and more powerful than Adobe Bridge or Photoshop. 

Photoshop vs. Lightroom 

© 2016 Mark Fitzgerald 



!  Lightroom is not a replacement for Photoshop. 

!  Lightroom is more like a combination of Adobe Bridge 
and Adobe Camera Raw (ACR). 

!  Lightroom’s main tasks are file organization, photo 
editing, and a variety of output options. 

!  Lightroom is designed to handle most aspects of a 
photographer’s workflow. 

!  Lightroom works with JPEG, TIFF, PSD, PNG, raw files 
and many common video files. 

What is Lightroom? 
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! A library’s card catalog has an entry for every 
book on the library’s shelves, with information on 
each of those books and where they’re stored. 

! Lightroom creates a catalog for the photos you 
import into it. Information about each file, including 
JPEG previews of it, are stored in the catalog. 

! Just as the books in the library are not stored in the 
card catalog, the photos on your hard drive are not 
stored in the Lightroom catalog. The catalog is a 
reference to those photos. 

Like the Library Card Catalog 
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Importing 
Photos 



! Use the area at the top-center of the import dialog to 
choose how photos are managed as they’re imported. 

! When importing new photos from camera card, choose 
Copy and then use the panels on the right to determine 
where the photos are stored on the hard drive, what to 
name them, etc. 

! When importing existing photos already on your hard 
drive, Choose Add so photos are added to the catalog 
without moving or renaming them. When this option is 
chosen, there are fewer panels on the right to work with. 

Importing Photos into Lightroom 
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!  Apply a metadata template to add your name and 
other information to the metadata of all imported files.  
1.  Click on Metadata menu and choose New. 

2.  Add your name to the Copyright field. This way you 
can use that field later when adding a watermark to 
photos as they are output. 

3.  Fill in any other important information. 

!  If two photographers are sharing a system, create a 
template for each user. 

☞  You can also create a metadata template by choosing 
Metadata > Edit Metadata Presets. 

Creating a Metadata Template 
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1.  When the Import dialog opens, select your card from 
the list on the left under Source. If you’re uploading 
from a camera card, it should be automatically selected. 

2.  Choose Copy at the top-center to copy photos from the 
camera card. (Steps 3 and 7 determine where the 
location they are copied to.) 

3.  Use the folder tree on the bottom-right to locate and 
click on your main folder. Remember that a shoot 
subfolder can be added in an upcoming step. 

4.  File Handling panel: Choose Standard preview size 
here. Choose “Don’t Import Suspected Duplicates” to 
prevent the reimport of previously imported photos. 

Importing from Camera Card 
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5.  File Renaming: Deselect this option to maintain original 
camera file naming. 

6.  Apply During Import: Add any global keywords that 
apply to all images, such as league, place, job number, 
and photographer. 

7.  Destination: Select “Into Subfolder” and choose “Into 
One Folder from the Organize menu. Type the name of 
the job folder/photographer ID into the textbox.  

☞  Most settings (except keywords) are “sticky”- they’ll be 
the same the next time you import so be sure to 
change the subfolder name for each import. 

Importing from Camera Card (2) 
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Quick 
Organization 



! Grid View Options: In Grid view choose View > View 
Options, (Cmd/Ctrl+J). This allows you to customize the 
information that’s displayed in Grid and Loupe views. 

" Select Show Grid Extras and then choose Expanded Cells to 
add four labels to the top of each thumbnail. Determine what 
info to display for each label. 

!  Loupe / Develop View Options: In Loupe or Develop view 
choose View > View Options, (Cmd/Ctrl+J).  

" Select Show Info Overlay then use the fields in the Loupe Info 
sections to customize the information. 

" After setup, Use the “i” key to cycle through Info 1, Info 2, and 
no info. 

Customize Your View Options 
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! Do all file management in Lightroom. If you don’t 
the catalog will get confused and Lightroom won’t 
be able to find the photos. 

"  Delete photos in Lightroom. 

"  Move photos in Lightroom. 

"  Rename photos in Lightroom. 

Lightroom’s Golden Rule 
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!  Deleting photos: Select them and press Delete key. 

"  Choose Remove to remove a file from the 
catalog, but keep it on the hard drive.  

"  Choose Delete from Disk to remove and delete. 

!  Moving files/folders: When relocating files and folders 
(click and drag) inside of Lightroom so that Lightroom 
keeps track of them as they’re moved on the hard drive. 

☞ Tip: When clicking and dragging thumbnails, click and 
drag by the image, not the border around it! 

Deleting & Moving Photos 
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!  Because Lightroom uses a catalog, when files are 
moved or deleted outside of Lightroom, it doesn’t 
know where they went. A “?” icon is displayed beside 
missing folders or files. If you know where the folder/file 
was moved to, you can click on the ? icon and then 
inform Lightroom where the file/folder is located. 

☞ Tip: If you don’t know where a file or folder went, try 
synchronizing its folder or its folder’s parent folder. 
(See next slide.) 

Dealing with Missing Files & Folders 
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! Another way to locate missing files is to synchronize the 
folder. This allows you to let Lightroom look at a folder 
and check for files that are no longer in it. It also checks 
for new files that haven’t been cataloged, and any 
metadata changes caused by outside programs (like 
Photoshop).  

! To synchronize a folder: right-click on the folder and 
choose Synchronize Folder. A dialog opens informing 
you of how many new photos are found and how many 
are missing. 

! Choose Show Import dialog to view the found photos. A 
good idea when the number of photos is large. 

! https://www.youtube.com/watch?v=xTOzjLGUHJA 

Synchronizing Folders 
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!  Keyword Tags panel: Add a new keyword by typing in 
the “Click here to add keywords” textbox or the larger 
box above. 

!  Keyword Suggestions panel: Based on existing 
keywords applied to the image and keywords used on 
images captured at the same time. 

! Keyword Sets panel: Recent Keywords tracks the nine 
most recently used keywords. Click on one of them to 
add or remove it from the selected image. 

! You can add or remove keywords to a single image or 
groups of selected images in the Library Grid view. 

Using the Keywording Panels 
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! Organize your keywords: The Keyword List panel can 
get quite crowded. It’s necessary to organize groups of 
keywords. Do this by creating main, “container” 
keywords and then click and drag sub-keywords into 
them. Collapse container keywords when you’re not 
using them. 

! Filtering for keywords: Click on the arrow to the right of 
a keyword in the Keyword List to filter the entire catalog. 
You can also use the Library Filter bar (see upcoming 
slide) to filter the current folder for date and other 
metadata. 

Working With Keywords 
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! Use colored labels to identify winners and losers. I use red 
for files to delete and green for files I want to take a closer 
look at. Click the color swatches on Toolbar to add or 
remove labels. 

! Add stars for a second rating level – your favorites of the 
green labeled images. 

! Use the Library Filter bar (\) to filter a folder for labels or 
flags.  

" Filter for red, select all, then delete.  
" Filter for green and then take a closer look. Add 1 or 

2 stars to files that are winners. (If you’re a pro, this is 
something you can do with your client.) 

☞ Labels and stars are applied globally. (Flags are not.) 

Using Labels and Stars 
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! A collection is a virtual grouping of photos. When you add 
a photo to a collection, it remains in its original folder. 

! A collection is a great way to organize photos you plan to 
show to clients. 

! To create a collection, click the + symbol at the top of the 
Collections panel and choose Create Collection. Give the 
collection a meaningful name and add your highest rated 
photos to it. 

! You can also synchronize collections with Lightroom on 
your mobile devices, which is a great way to have a 
portable portfolio. 

Creating a Collection 
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! The Filter bar is only visible in the Grid view. It works 
with the currently active folder or collection. (Choose All 
Photographs from the Catalog panel to filter everything.) 

"  Text: Filter for text in any field or a specific field. 

"  Attribute: Filter for color labels, stars, or flags - or a 
combination, such as green label with 2 stars. 

"  Metadata: Filter for any metadata, such as date or 
type of camera used. 

! Second filter bar on filmstrip: This second basic filter 
bar is in all modules when the Filmstrip is visible. 
Caution: Be sure not to confuse it with the colored 
swatches on the Toolbar that are used to add labels. 

Using the Filter Bar 
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Developing 
Photos 



!  Most cameras enable you to shoot with camera profiles, such as 
Portrait, Landscape, Neutral, Standard, etc. However, when you 
shoot raw files, these settings are replaced by the Adobe Standard 
profile. (i.e. Canon = Picture Style, Nikon = Picture Control, etc.) 

!  You can change the standard profile to a different one in Profile 
menu (at the top of the Basic panel in the latest LR, or in the 
Calibration panel in previous versions.) 

!  A profile modifies colors as well as contrast to provide a 
specific look. It is important to consider adjusting white balance 
after changing a profile because a profile is more about the 
differences between colors than overall color balance. 
☞ Lightroom Classic CC 7.3 also has a new section of 

creative profiles in the Profile section of the Basic panel.  

Working with Profiles 
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!  White Balance: White Balance is used to neutralize the 
influence of the color of the light that illuminated the scene you 
photographed. 

!  If you’re working with raw files, you can use the WB menu at the 
top of the Basic panel to choose one of the white balance 
settings your camera uses. 

!  If you have an exposure target (such as a gray card) in image, 
you can use White Balance tool (W) to “click-balance” on the 
target. 

!  The goal with the White Balance tool is to neutralize a color 
cast in a tone that should be gray, white, or black. 

!  Use the Temp and Tint sliders to fine tune overall color. 

Adjusting White Balance 
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!  The Histogram panel has two small triangle icons above each 
end of the histogram. If these triangles display a color or white, 
clipping is occurring.  

!  Hover over these icons to see where the clipping is in the image. 
Highlight clipping is red. Shadow clipping is blue. 

!  Click on a clipping preview triangle to turn on the red and blue 
clipping previews so that it isn’t necessary to hover over the 
icons to see them. 

☞ An alternate method for seeing a on-image clipping 
preview is to hold down the Option/Alt key while clicking 
and dragging Tone sliders. 

Using the Histogram’s Clipping Previews 
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1.  Adjust the white point to control highlight brightness and 
clipping. Be careful about clipping highlights. (Sometimes, 
though a “flat” image needs brighter highlights) 

2.  Adjust black point to control shadow clipping. Pure black in  
appropriate areas of the image can add depth. (Try not to clip 
shadow detail on the main subject.) 

☞ White point + black point = overall contrast. 
3.  Adjust Exposure slider whenever it’s necessary to modify 

overall brightness. 
4.  Accentuate shadows and highlights in the midtones using the 

Highlights and Shadows sliders. 

Concepts of Tonal Adjustment 
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1.  Exposure: Adjust the overall brightness with this slider. 
2.  Whites: Use this slider to control highlight clipping. 

3.  Blacks: Use this slider to control shadow clipping. 

4.  Highlights: Used to lighten or darken highlights tones. 

5.  Shadows: Used to lighten or darken shadow tones. 
☞ Hover over a slider then look at the histogram to see a preview 

of the corresponding tonal range controlled by the slider. 

!  Clarity: Use plus value to increase midtone contrast and add 
some sharpness. Using negative values softens. 

!  Dehaze: Used to remove atmospheric haze. (Was recently 
moved from the Effects panel.) 

!  Vibrance: Affects saturation of subtle colors more than others. 

!  Saturation: Affects color intensity of all colors equally. 

Basic Panel Adjustments 
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! HSL: Adjust the Hue, Saturation, and Luminance of 
individual color ranges. Use the Targeted Adjustment tool 
to click and drag up and down to change values. If that 
range contains overlapping colors, both sliders will be 
adjusted. 

! Color: A different way of presenting the same controls 
that are in HSL. The main exception is that there isn’t a 
Targeted Adjustment tool. 

! Black and White: Choose B&W to control how colors are 
mapped to gray. Sliders work the same as HSL sliders for 
precise grayscale tonal adjustment of color ranges. 

Working with the HSL/Color/B&W Panel 
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!  Lightroom makes it easy to edit batches of similar photos.  

!  Adjust one photo, then select multiple similar photos and 
click the Sync button at the bottom-right of Develop 
module. (This button only shows when multiple files are 
selected. It replaces the Previous button.) 

! When the Synchronize dialog opens, choose the settings 
you want to synchronize and then click the Synchronize 
button. 

 

Editing Batches of Similar Photos 
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!  Lightroom comes with a number of Develop presets.  
However, you can easily create your own.  

1.  Make the desired adjustments to a photo. 

2.  Click the Create New Preset button (+). 

3.  When the dialog box opens, name the preset and 
choose the settings you want to include from the list. 

 Apply the preset to selected photos by choosing it from 
the Presets panel. 

☞ To modify a preset, right click on it and choose Update 
with Current Settings. 

Using & Creating Develop Presets 
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!  If there is a specific Develop setting you use all the time, 
such as Lens Correction, it’s a good idea to save it as a 
default setting. 

1.  Choose a file that has not been developed or Reset one 
that has been developed. 

2.  In the Develop module apply the desired settings. 

3.  Choose Develop > Set Default Settings > Update to 
Current Settings. 

☛    You should do this for each of the cameras you use. 

Saving Default Settings 
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!  Lightroom comes with a number of Develop presets.  
However, you can easily create your own.  

1.  Make the desired adjustments to a photo. 

2.  Click the Create New Preset button (+). 

3.  When the dialog box opens, name the preset and 
choose the settings you want to include from the list. 

 Apply the preset to selected photos by choosing it from 
the Presets panel. 

☞ To modify a preset, right click on it and choose 
Update with Current Settings. 

Creating Custom Develop Presets 
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Mastering 
the Tools 

36 



!  The Lightroom Toolstrip has five powerful tools. When you 
choose one, its dropdown panel opens below the Toolstrip.  

" Crop Overlay – Nondestructive, flexible cropping. 

" Spot Removal – Remove spots and distractions. 

" Red Eye – Follow the instructions to quickly remove red eye. 

" Graduated Filter – Add linear gradients to sky, etc.  

" Radial Filter – A radial version of the Gradient Filter. 

" Adjustment  Brush – Paint localized adjustments anywhere 
in the image, such as burning and dodging. 

Toolstrip Overview 
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!  Choose a preset from the menu to crop to specific aspect ratio. 
Change orientation of the crop by clicking and dragging a corner 
in the “wrong direction”. 

!  Click on the lock icon to lock/unlock aspect ratio. Use the “X” 
key to flip the orientation between portrait/landscape. 

!  Rotate the crop by moving the cursor outside the box and 
clicking and dragging up or down. 

!  Use Straighten tool to rotate by drawing on the image.  

!  Click Close on the panel or Done on the Toolbar to apply crop.  

!  Cropping can be modified at any time. It can be completely 
undone by choosing Reset at the bottom of the Crop panel. 

 

Using the Crop Overlay Tool (R) 
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!  Adjust the size of the brush using your scroll wheel.  

!  Click on a spot or paint a shape to cover the area. 

!  Use the Feather slider to change edge quality of your stroke. 

!  A sample is automatically selected from the surrounding area 
(indicated by the second circle). Click and drag this circle to 
change the sampled area. 

!  Choose Clone or Heal before or after removing a spot to 
change the way the tool blends the sample. Clone takes a literal 
sample. Heal blends the color of the sample, but not the texture. 

!  Click a pin to activate a previous application of the tool. Modify it 
using the sliders, or remove it by pressing the delete key. 

Using the Spot Removal Tool 
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! Graduated Filter (M) ~ Apply gradients anchored to edges 
of the image. 

! Click and drag inward from any edge or corner to create a 
gradient. Adjust the settings before or after creating the 
gradient. 

! Click the middle indicator line to rotate the gradient after 
it’s in place. 

! Multiple gradients are indicated with individual “pins”. 
Make a previously applied gradient active by clicking its pin. 
Then modify its adjustment sliders or delete it using the 
Delete key. 

Using the Graduated Filter 
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!  Range Masking is a cool newer feature in Lightroom enables 
you to control which areas are affected by a gradient.  

!  You can range mask a gradient based on color or brightness 
using the menu at the bottom of the panel. 

!  When you choose the color masking option, select the 
eyedropper to select the color you want the mask to affect. Click 
and drag to select a range of colors. 

!  When masking based on brightness, use the Luminance 
option. Then use the range slider beneath it to mask out tonal 
ranges you don’t want to affect. 

☞ You can also use Range Masking with the Radial 
Gradient and the Adjustment Brush tools. 

Range Masking a Gradient 
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!  Radial Filter (Shift+M) ~ Create elliptical gradients with the 
same qualities of the Gradient Filter. 

!  A great way to add an off-center vignette or a vignette with 
special qualities, such as desaturation or soft focus (as opposed 
to post-crop vignetting). 

!  Click and drag outward from the center of the area you want to 
isolate. Adjust the settings before or after creating the gradient. 

!  Modify the ellipse by clicking and dragging anchor points. 

☞  Hold down the Option/Alt key to adjust one anchor point. 

!  Use the Feather slider to modify the edge hardness/softness. 

!  Click and drag outside the ellipse to rotate its angle. 

Using the Radial Filter 
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!  Adjustment Brush (K) ~ Paint tonal or other changes into an 
image. Use the Feather slider to soften the edge of the stokes. 

!  Use the Flow slider to control how much paint is delivered to 
the brush. Multiple strokes are additive. 

!  Use the Density slider to control opacity. Multiple strokes are 
not additive. 

!  Select Auto Mask to automatically paint in specific areas. Just 
remember to deselect it when you’re done. 

!  Adjust one or more sliders and begin painting. 

!  To apply different settings to another area, click New. 

!  Use Erase to remove paint on selected pin/area. 

☞ Choose Show Selected Mask Overlay on the Toolbar to 
display a red mask of painted areas on the selected pin.  

Using the Adjustment Brush 
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!  Use the Exposure slider to “burn and dodge”. 

!  Paint with high Feather values for a softer edge. 

!  Reduce Flow when you want to “build-up” the effect with 
successive brush strokes. 

!  Click New to start a new treatment for a different area. 

!  The brush settings at the bottom of the panel must be adjusted 
before painting.  

!  Adjustment sliders of the selected pin can be modified after 
painting.  

☞  It’s important to monitor which sliders are adjusted before 
beginning. Easy to accidently modify unintended aspects. 
Always check every setting before beginning a new 
session with the Adjustment Brush or gradient tools. 

Adjustment Brush Tips 
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Exporting 
Finished 

Files 



! Exporting is used to create derivative files for other uses. For 
example; if I need to email a small version of a raw file, or send 
a JPEG file to a lab for printing. 

! Use the Export dialog to create the type of file you want and to 
save it to the desired location. 

The Export Dialog 
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! Select files and click the Export button in the Library module. 

! Export Location: Add files to a specific folder and/or save in 
original folder. You can also add to the catalog on the fly. 

! File Naming: Create a new filename or leave the same. 

! File Settings: Determine what type of file to create: TIFF, PSD, 
JPEG, DNG, Original (which is a duplicate of the original). 

!  Image Sizing: Resize to specific size and choose resolution. 
Choose Long Edge to size mixed vertical and horizontal more 
easily. 

! Output Sharpening: Basic sharpening for print or screen. 

Exporting Photos Overview (1) 
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! Metadata: Minimize Embedded Metadata to keep 
metadata private. Add a watermark from the copyright 
field of the metadata preset. 

! Post-Processing: Open files in Finder/Explorer. Open 
files into Photoshop for advanced editing. 

! Use Lightroom’s default presets as starting points. 
Customize with the settings you want and save your 
own personal User presets. 

! To update a User preset with new settings, right-click 
on it and choose Update with Current Settings. 

Exporting Photos Overview (2) 
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1.  Select the LR preset For Email (Hard Drive) as a starting 
point then personalize. 

2.  Choose the desired export location – usually a folder on the 
desktop. 

3.  Choose the file size in pixels on the longest edge. 800 pixels 
is a good starting point. 

4.  Choose file quality – somewhere between 50 & 60. 

5.  Add any other settings, such as sharpening or watermarking. 

!    Save a preset to record your settings. 

Exporting Email to Hard Drive 
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! The Watermark Editor can be opened directly (Lightroom > 
Edit Watermarks (Mac); Edit > Edit Watermarks (Windows). 
Or you can open it by choosing Edit Watermarks from the 
Watermarks popup menu in the Export dialog. 

! Use the dialog to create a watermark with the font and layout 
you prefer and then save it so it will be added to the 
Watermark menu. 

! Consider creating similar custom watermarks for the right 
and left. To do so, create one watermark and save it. Then 
open the Watermarks Editor and modify the one you just 
saved. The choose Save Current Settings As New Preset from 
the menu at the top of the Watermark Editor. 

Creating Custom Watermarks 
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! Use Lightroom’s default presets as starting points. 
Customize with the settings you want and save your 
own personal User preset. 

! Click the Add button at the bottom-left of the Import 
dialog and then type a name for your preset. 

! To update a User preset with new settings, right-click 
on it and choose Update with Current Settings. 

Saving An Export Preset 
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Final 
Thoughts  
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